
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Greening VACO requires a collaborative effort; 
we thank you in advance for your participation! 

Place your message here. For maximum 
impact, use two or three sentences. 
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Welcome 
The Department of Veterans Affairs (VA) as an agency 
is making great strides towards operating more energy 
efficient facilities, using more renewable energy, 
“greening” its vehicle fleets with alternative fuel vehi-
cles, and achieving other milestones on the path to 
environmental sustainability.  In addition to agency 
activities, each and every one of us has daily opportu-
nities to contribute to a healthier indoor and outdoor 
environment.  The many actions we as individuals can 
take to reduce, reuse, and recycle can also generate 
cost savings that VA can rededicate to caring for Vet-
erans and their families.  Please take advantage of the 
information and resources provided in this document. 
 
Purpose of the Greening Action Guide 
and Toolkit 
The Greening VACO Working Group and its Subcom-
mittees have developed resources such as this Green-
ing Action Guide and Toolkit to help VACO execu-
tives,  managers, and employees plan and implement 
actions that can improve VACO’s overall energy effi-
ciency, conserve resources, and demonstrate environ-
mental stewardship. 
• Executives and managers, with help from staff, may 

use the Greening Action Guide as a resource in 
greening their organizations.  

• Staff, managers, and executives can use the more 
specific recommendations in the Toolkit to help 
implement the Greening Action Guide. 
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Additional Resources for Going Green 

VA Office of Asset 
Enterprise Management 
(OAEM)  

http://www.va.gov/oaem/  

Environmental Protection 
Agency (EPA) http://www.epa.gov/greeningepa/ 

National Center for 
Environmental Health 
(CDC)  

http://www.cdc.gov/nceh/  

United States Department 
of Justice (DOJ) – Green 
Your Office 

http://www.usdoj.gov/jmd/ep/
green-your-office.htm 

FedCenter – Sustainability  http://www.fedcenter.gov/
programs/sustainability/ 
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Greening Action Guide 
This Greening Action Guide was developed as guidance for VA execu-
tives and managers as they implement sustainable practices with help 
from their staff.  The goal is to develop an environmentally aware and  
responsible culture that conserves resources. The Greening Action 
Guide specifies a lead office to handle particular actions.  Unless other-
wise noted in the “lead” column all offices can implement these actions.   

Anticipated results: 
 

1. Reinforcement of Green Routine behavior modifications 

2. Easily accessible information on how to implement the actions  

Objective 1: Establish a precedent of routine sustainable practices 
Strategy 1.1: Top-Down participation & acceptance 

# Action Target 
Date 

1.1.1 Promote Green Routine strategies during 
VACO new employee orientation 

Jan. 2010 

1.1.2 Include Environmental Stewardship as a part 
of Executive Performance Plans 

June 
2010 

Strategy 1.2: Bottom-Up participation & acceptance 

# Action Target 
Date 

1.2.1 Designate 1 or 2 Green Champions in each 
staff office and Administration to promote 
Green Routine actions 

Jan. 2010 

Strategy 1.3: Leverage technology in communicating plans, strategies & suc-
cesses 

# Action Target 
Date 

1.3.1 Update content and maintain Green Routine 
website  

Jan. 2010 

1.3.3 Watch the Senior Mgmt video on Green Initia-
tives  

Jan. 2010 

1.2.2 Develop a Green Team to assess progress im-
plementation of strategies and gather 
results 

Jan. 2010 

1.3.2 Use VACO Daily News alerts, VACO webpage 
and articles to promote Green Routine 
website and events 

Jan. 2010 

Lead 

HRM, 
OAEM& 

Managers  
 

HRM & 
Managers 

Lead 

 

 

Lead 

OAEM & 
OIT 

OPA 

 

1.3.4 Utilize the Learning Management System (LMS) Feb. 2010 EES  
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To use these styles for all documents: Make any additional style 
changes to suit your needs. When you are happy with your 
settings for fonts and line spacing, set these styles as the de-
fault set for all new documents. Here’s how: on the Home tab, 
click Change Styles, point to Style Set, and then click Save as 
Quick Style Set. Type a name for this style set, then click Save. 
You can now apply this style set in new documents by select-
ing it from the Style Set list. 

 
Layout and Printing Tips 
Tables: Consider using tables to lay out multiple columns of data 

across the page. 
 
Distribute Electronically: Consider saving your document to XPS or 

PDF format and distributing electronically (via e-mail, shared 
server, or web site) for online viewing.  

 
Automatic Paper-Saving Adjustments: When printing, have Word 

reduce the number of pages in your document by using the 
Shrink One Page option available in Print Preview. 

 
Printing Multiple Pages per Sheet: Print multiple sheets per page 

using the Zoom option, Page per sheet, in the Print dialog box. 
Many printers also offer this type of option in the printer Prop-
erties dialog box, and you may get faster output by making 
this choice with the printer rather than through Word. (Use the 
setting in Word or your printer only, not both.) 

 
More Paper Tips When Printing 
 
Duplex Printing: If your printer supports this option, use duplex (or 
two-sided) printing. 
 
Columns: For documents with a large number of short lines, con-
sider using table columns to place multiple columns of data 
across the page. 
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http://office.microsoft.com/en­us/templates/
results.aspx?qu=conservation&av=TPL000 
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Paper-Saving Tips  
 
There are a number of settings, detailed below, which conserve 
space for documents that are viewed primarily online but may 
also be printed. Here are Microsoft Word 2007 instructions for 
making these settings the default for your new documents. 
 
Margins 
Margins are set to 0.5” on all sides, to maximize available docu-
ment space.  
 
Using headers and footers: If you plan to use a header or footer 

for your document, you should adjust the top or bottom mar-
gin or change the header or footer distance from edge set-
ting in the Page Layout dialog box. 

  
To use these margins for all documents: Open a new document 

(which will be based upon your Normal template), and set 
your margins and header/footer distance as desired. Click 
the Page Layout tab, click the Dialog Box Launcher below the 
Page Setup group, and then, in the Page Setup dialog box, 
click the Default button.  

 
Styles 
The Traditional style set has been selected for this document, with 
some modifications to eliminate excess white space. Paragraph 
spacing before heading styles has been slightly decreased, and 
the Office theme fonts have been selected.   
 
Line Spacing: If you wish to adjust the spacing above headings 

and between paragraphs, modify the corresponding Head-
ing and Normal styles. 

 
Character Spacing: If you wish to compress the spacing between 

characters to fit more characters per line, Word provides a 
kerning feature. On the Home tab, in the Font group, click the 
Font Dialog Box Launcher. In the Format Font dialog, on the 
Character Spacing tab, select the Kerning for fonts check box 
and set the value you want.  
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Strategy 2.1 : Put into practice Green Meetings 
    Reduce Principle: Paper and Energy Conservation                                                        

# Action Target 
Date 

2.1.1 Print multiple PowerPoint slides per page Jan. 2010 

2.1.2 Use projectors rather than handouts (if 
available) 

Jan. 2010 

2.1.3 Print black & white handouts rather than 
color when applicable 

Jan. 2010 

2.1.4 Eliminate the use of event flyers distributed 
at building entrances 

Jan. 2010 

2.1.5. When sending meeting announcements, 
include reminder to turn off lights 

Jan. 2010 

Lead 

 

 

 

 

 

2.1.6 Email handouts before meetings, giving 
attendees the option to print  

Jan. 2010  

Objective 2: Implement the sustainability principles of reduce, reuse and 
recycle.  

Anticipated results: 
1. Decreased paper purchases 
2. Reduced toner cartridge purchases 
3. Reduced maintenance on printers and copiers 
4. Decreased paper waste for recycling 
 

Strategy 2.2: Reduce Paper Waste and Eliminate Unnecessary Printing 
    Reduce Principle: Paper and Energy Conservation  

# Action Target 
Date 

Lead 

2.2.1 Mandate all printers default to duplex 
(double-sided) printing if available 

Nov. 
2009 

OAL & 
Managers 

2.2.2 Print only what is necessary and encourage 
less color printing (default to grayscale or 
black & white) 

Jan. 2010  

2.2.3 Remove desktop printers that do not print 
duplex 

Jan 2010 Managers 
& OIT 

G
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Strategy 2.3: Improve Electricity Efficiencies 
      Reduce Principle: Energy Conservation 

# Action Target 
Date 

2.3.1 Turn off lights in individual cubicles and offices 
when appropriate (i.e. at the end of day or 
during periods of  absence > 2 minutes) 

Oct. 
2009 

2.3.2 Unplug cell phone and PDA chargers when not in 
use (to reduce unnecessary electric loads) 

Nov. 
2009 

Lead 

 

 

Strategy 2.4: Establish and promote the exchange of unused supplies  
Reduce and Reuse Principle: Save money and resources by sharing and 
exchanging unused supplies 

# Action Target 
Date 

2.4.1 Create a temporary space for unused supplies, 
either building specific or within individual 
offices 

 June 
2010 

2.4.2 Conduct periodic office supply swaps (virtual or 
physical) that allow employees and offices to 
exchange used or unneeded supplies rather 
than purchase new ones. 

June 
2010 

Lead 

 

Greening 
VACO 
Work-
group & 
OIT 

 

Anticipated results: 
1. Reinforcement of Green Routine behavior modifications 
2. Cost savings due to office supply sharing and waste reduction  
3. Energy cost savings 
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Greening Your Off-Site Meetings and Conferences 

Here are 10 easy tips you can apply to any meeting to make it 
more environmentally responsible: 
 
1. Put it in writing. Establish an environmental statement or 

policy for the meeting, and get buy in for it from the meeting 
host organization's management.  Share the policy with 
suppliers, attendees and speakers.  Click here for a 
sample (DOC file). 

2. Use paperless technology. Use new media and electronic 
technology to cut down your paper use.  Create a 
conference web site; offer electronic registration and 
confirmation; and advertise using the web and/or email. 

3. Meet local. Reduce distances traveled by speakers and 
attendees.  Choose a host city that is close to as many 
attendees as possible. Within the city choose a venue and 
hotel that are close to the airport and within walking 
distance of each other. 

4. Recycle. Ask your hotel and meeting venue to provide 
visible and accessible recycling services for paper, metal, 
plastic and glass. 

5. Bulk up. Have your food & beverage service provider use 
bulk dispensers for sugar, salt, pepper, cream and other 
condiments. 

6. Lighten your stay. Choose a hotel that offers a linen reuse 
program and bulk dispensers for shampoos and soaps in 
guest suites. 

7. Eat green. Have meals planned using local, seasonal 
produce. 

8. Close the recycling loop. Have all printed materials 
published on recycled paper, using vegetable-based inks, 
and printed on both sides of the page. 

9. Save energy. Coordinate with the meeting venue to ensure 
that lights and air conditioning will be turned off when rooms 
are not in use. 

10. Spread the word!  Tell attendees, speakers and the media 
about your success.  You'll be surprised - green efforts are 
contagious. 

 
Source: www.BlueGreenMeetings.org 
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Easy Resource and Energy Conservation Strategies 
(See 3-5 for “how-to” paper-saving tips) 
 

Paper Conservation 
• Use double-sided copying whenever possible 
• Single-space documents 
• Reduce margin size to prevent white space and pages with 

little text. 
• Review documents on the computer screen before printing 
• Collect and reuse paper already used on one side (for 

example, for drafts and internal memos) 
• Use scrap paper for memos and telephone pads 
• Circulate and share copies of internal publications and 

documents 
• Post office announcements on bulletin boards 
• Faxing:  

• Scan and email documents or when faxes are 
necessary, eliminate fax cover sheets or use alternatives 
such as removable sticky notes; 

• program your fax to deliver “ confirmation ” sheets only 
for failed communications;  

• update your “ broadcast ” fax lists;  
• Use reusable or two-way envelopes and mailing pouches (for 

example, for inter-office and interdepartmental 
communications) 

 

Energy Conservation 
• Turn off unnecessary lights 
• Turn off office and/or overhead lights if possible when leaving 

the office for meetings, etc. 
• Use natural lighting and turn off lights near windows if possible 
• If possible, use task lighting to directly illuminate work areas 
• Unplug equipment that drains energy even when not in use (i.e. 

cell phone chargers, BlackBerry chargers, fans, coffeemakers, 
radios, etc.) 

• Close or tilt window blinds to block direct sunlight to reduce 
cooling needs during warmer months, and open blinds in winter 
months 

• Copy only what you need 
• Use reusable coffee mugs instead of disposable cups 
• Space heaters are prohibited, they use large amounts of 

energy and present a fire risk.  
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Strategy 2.5: Recycle Principle 

# Action Target Date 

2.5.1 Do not shred paper that can be recycled 
(e.g., newspapers, unclassified memos 
and documents, etc.)  

Oct. 2009 

2.5.2 Recycle all materials for which collection is 
available (e.g., bottles, cans, toner 
cartridges, cardboard, etc.) 

Oct. 2009 

Lead 

 

 

Strategy 3.1: Specify green products and services when using purchase cards 
and contracts 

# Action Target Date 

3.1.1 When purchasing new electronics, choose 
products with Energy Star qualifica-
tion.  For electronic products for which 
there are EPEAT standards, choose 
EPEAT registered products. (as man-
dated) - www.energystar.gov and 
www.epeat.net  

Oct. 2009 

3.1.2 When purchasing offices supplies and furni-
ture, choose recycled, biobased, and 
other environmentally preferable 
products (as mandated) - 
www.fedcenter.gov/Documents/
Index.cfm?id=11767  

Oct. 2009 

Lead 

 

 

Objective 3: Ensure the acquisition of green products and services  

Anticipated results: 
1. VACO compliance with federal statutes, executive orders, and 

the Federal Acquisition Regulation. 
2. Increased market demand for green products and services 
3. Reduced environmental impacts of VACO acquisitions 
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VACO Toolkit 
This Toolkit contains specific green recommendations, helpful 
hints, and resources that may be used by all types of VACO 
employees (i.e., staff, managers, and executives) as we 
implement the Greening Action Guide. 
 
How to Start Greening Your Office Environment 
• Schedule a meeting 
• Select a Green Champion in your office 
• Conduct a baseline assessment of current practices within 

your office 
• Set goals and priorities from assessment 
• Developing an Office Greening Action Guide (see template 

on page 3-7) 
• Develop an easily-adaptable system to demonstrate progress 

towards goals 
• Create a Green “buddy system” among interested staff to 

encourage continued support of goals 
 
 
 
Greening VACO requires a collaborative effort; we thank you in 
advance for your participation! 
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Green Champions:  Who in your office will lead the greening ini-
tiatives? 
 

The VACO Green Routine Working Group recommends selecting 
a Green Champion in your office. The most successful             eco
-friendly initiatives require this leader help spearhead the efforts.  
Offices will see the best results where these champions and their 
offices are both accountable for and rewarded for their environ-
mental awareness and monitoring of employee work habits. 
 
Role of Green Champions: 
• Remind co-workers to reduce, reuse and recycle. 
• Help employees follow the tips provided in this Toolkit.  
 
 
Such practices are: 
1.  Double-sided printing if possible 
2.  Print only when necessary 
3.  Strive for electronic meetings; avoid paper copies 
4.  Print in black & white; use color only when necessary 
5.  Set monitor to turn off after 10 minutes or less 
6.  Turn off all cubical and office lights when not in use 
7.  Discard all paper waste in paper recycle bins 
8.  Make sure all used printer cartridges are recycled 
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